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Lesson 5 

The Features Toolbar 
 

 
 
 
The Features toolbar has six sections.  They are Sketched feature tools, Thread, Placed feature tools, 
Design Element tools, Pattern Feature tools, and Work features. 
 
The Sketched feature tools use sketched geometry to build features.   
The Thread tool maps the image of a thread onto a cylindrical face. 
The Placed feature tools add finishing touches to existing features.   
Design element tools create or add predefined features to a model.  
Pattern feature tools add multiple instances of existing features.  
Work features create work planes, work axes, or work points that you can used to define other features in a 
model.   
 
You’ll notice that when you start your part most of the Features tool bar is grayed out.  That’s because 
Inventor automatically disables any tools you don’t need until you need them.  Those tools will become 
available once you have created the appropriate features. 
 
Sketched Feature Tools 
 

 
 
The eight options of this section are Extrude, Revolve, Hole, Shell, Rib, Loft, Sweep and Coil. 
 

  
Extrude 
 

 

The Shape button selects a profile to extrude. If there are multiple profiles and none are selected, click 
Profile and then click on one or more profiles in the graphics window. 

Inventor allows you to extrude more than one profile at a time.  When you select a profile it will highlight 
to indicate that it is part of the selection set.  To remove a profile from the selection set, hold down Ctrl and 
click a profile.  If your selection set is not what you want and you were unable to de-select a profile, just 
press on the Cancel button and start over. 
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Join 
Adds the volume created by the extruded feature to another feature. 

 

Cut 
Removes the volume created by the extruded feature from another feature. 

 

Intersect 
Creates a new feature from the shared volume of the extruded feature and another 
feature. Material not included in the shared volume is deleted. 

 
Surface 
Creates a 3D surface. 

The four buttons in the middle of the Extrude dialog box control the type of extrusion.  The top button 
performs a ‘Join’ operation.  The second button performs a ‘Cut’.  The third button performs an ’Intersect’.  
The bottom button creates a surface.  You can drag the previewed profile using your mouse to determine 
the distance you want to extrude or enter a value into the dialog box under extents.   The operation is 
automatically previewed in the graphics window. 

 

 
 
Under the Extents section of the dialog box, there is a drop down that allows you to define how far you 
want to extrude the profile.  Your options are Distance, To, and From To. 
 
Distance 
Default method. Establishes the depth of extrusion between start and end planes. For a base feature, shows negative or positive 
distance of extruded profile or entered value. The extrusion end face is parallel to the sketch plane. 
To 
Allows you to select an ending face or plane on which to terminate the extrusion. You may terminate the feature on the selected face, 
or on a face that extends beyond the termination plane. In an assembly, the face or plane may be on another part. After you select the 
termination plane, choose one of the following: 

� Click the left button to terminate the feature entirely on the selected face.  

� Click the right button to terminate the feature on the selected plane and the extended face. 
 
From - To 
Allows you to select beginning and ending faces or planes on which to terminate the extrusion. In an assembly, the faces or planes 
may be on other parts. Not available for base features. 
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Inventor automatically saves your most common values.  You can also measure objects on the fly to 
determine what value you want to use.  You can use the Show Dimensions to select an existing dimension 
on the model to be used for the feature being defined. 
 
The buttons on the bottom of the Extents section determine the direction for the extrusion.  Inventor will 
automatically preview, so you can see if you have selected the correct direction. 
 
The Taper Angle sets a taper angle of up to 180 degrees for the extrusion (normal to the sketch plane). The 
taper extends equally in both directions. If a taper angle is specified, a symbol in the graphics window 
shows the fixed edge and direction of taper.  

 

 
 
 
 
 

   
Revolve 
 
A revolve is done similarly to an Extrude.  First you create the sketch using the Sketch toolbar.  Then select 
the Revolve button from the Features toolbar.  The Revolve dialog box will appear.  Select the profile to 
revolve.  Define the centerline or axis you wish to revolve around by picking the axis button and then 
selecting the appropriate centerline or axis.  The axis may be a work axis, a construction line, or a normal 
line.  The axis of revolution can be part of the profile or offset from it. The profile and axis must be 
coplanar. 

 

 

 
TIP:   To taper a feature in only one direction, create an extruded feature with no draft, then use the 
Face Draft tool to add draft to a specific face. 
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Under Extents, you determine the method for the revolution and set the angular displacement of the profile 
around a centerline. Click the drop-down arrow to list the extent methods, select one, and enter a value. 
Revolutions can be a specific distance or can terminate on a work plane or part face. 
 
 

 
 
For the angle, you can measure for an angle, show dimensions to help you determine a value or simply type 
in an angle. 
 
Finally, you can determine the direction for the revolve.  Inventor will preview the revolve so you can 
decide if you have defined it properly before pressing ‘OK’. 
 
Creating a Revolve 
  

 
 
Go to File->New. 
We begin our part by opening a new part under the English tab to ensure that our units are in inches. 
Left-click on Standard(in).ipt. 
 
Press ‘OK’. 
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Draw the sketch shown.  Note the axis line.  This will be used to revolve around. 
Inventor R4 comes with three line types: Normal, Construction, and Centerline. 
We can identify the axis line as a centerline by selecting it and then selecting Centerline from the drop 
down. 
 

 
 
 

 
The axis line now changes appearance to a centerline. 
 

Axis line 
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Right click and switch to ‘Isometric View’. 
 
 

 
Select the Revolve icon in the Features toolbar. 

 
 
Verify that the correct profile is highlighted.  If it is not, left-pick on the profile button in the Revolve 
dialog box and select the sketch.  Because we defined our axis line as a centerline, Inventor automatically 
knows how to revolve our profile. 
 
In the Extents drop-down, select ‘Full’ for a complete 360-degree revolution. 
 
Press ‘OK’. 
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Save this part as ‘wheel.ipt’.  We will be using this part later in the text when we create patterns. 
 
 

   
Hole 
 
The Hole tool creates parametric drilled; counter bored, or countersunk hole features. A single hole feature 
can represent multiple holes with identical configurations (diameters and termination methods). Different 
holes can be created from the same, shared hole-pattern sketch.  
 
Before you place a hole, you have to place a point or hole center using the Sketch toolbar.  Place the point, 
constrain it’s location and then you can proceed to the Features toolbar.   You can also select endpoints or 
center points on existing geometry as hole centers. 
 
Inventor’s hole dialog box is extremely advanced and has several ‘Gee Whiz’ features.  You can actually 
click inside the dialog box and modify the dimensions there.  You can define more than one hole at a time 
simply by selecting on those hole centers and adding them to the selection set.  So, for maximum 
efficiency, you can place all your hole centers using the sketch tool and then extrude them using the hole 
feature tool all in one shot. 
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Hole Types 
 

The Type Tab selects hole centers and specifies hole type. 

Centers Hole center points are automatically selected. Click to select endpoints or center points of 
geometry as hole centers. 

Hole type 

 

Drilled holes are flush with the planar face and have a specified diameter. 
This is the default. 

 

Counterbored holes have a specified diameter, counterbore diameter, and 
counterbore depth. 

 

Countersunk holes have a specified diameter, countersink diameter and 
countersink depth. 

 

Termination 

Distance Defines the termination method for the hole. Uses a positive value for the hole 
depth. Depth is measured perpendicular from the planar face. 

Through 
All  Extends a hole through all faces. 

To Terminates a hole at the specified planar face.  
Flip Reverses direction of the hole. 
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Hole Threads 

The Threads Tab sets values to define tapped holes. The hole is previewed according to the values you 
specify. 
Tapped Select the check box to define hole threads. 
Full Depth Select the check box to specify threads the full depth of the hole. 

Thread Type 
Either ANSI or Metric.  The default depends on which the user selected when Inventor 
was installed. 

Right 
Hand/Left Hand 

Determines the direction of thread. 

 
The threads will not appear in your model, but the information will be used when you move into the 
drawing stage of your design.  It will save you time and frustration to define any tapped holes here rather 
than relying on memory.   
 

 
 
Hole Size 
 
The nominal size and pitch callout pull downs display standard threads depending on whether the user set 
the drawing as metric or standard.  The drafting standard can only be changed in a drawing file.  You can 
decide to switch to a metric thread when you create your drawing file.  Use Tools->Drafting Standards to 
set your options.  
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Hole Options 
 

The Options tab defines the angle for countersunk holes and defines angle or flat tip for drill points. 

Countersink 
Angle 

For countersunk holes, click the down arrow to specify the angle of the countersunk head or 
select geometry on the model to measure a custom angle. The positive direction of the 
countersink taper is measured counterclockwise from the hole axis, normal to the planar 
face. 

Drill Point 
Sets the angle of the drill-point taper to the end of the hole. Select Flat or Angle point. Click 
the down arrow to specify angle dimension or select geometry on the model to measure a 
custom angle, if applicable. 

 
This dialog box grays out the Countersink Angle option unless Countersink is selected under Type. 
 

   
Shell 
 
 

 
 
The Shell tool removes material from a part interior, creating a hollow cavity with walls of a specified 
thickness.   
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Remove Faces Selects part faces to remove, leaving the remaining 

faces as the shell walls. Click to activate the part, 
then select the faces to remove. To reclaim a face, 
press and hold Ctrl and select the face.  
Selected faces are removed. Thickness is applied to 
remaining faces to create shell walls. If no part faces 
are selected for removal, the shell cavity is entirely 
enclosed within the part. 

Direction 

 

Inside  
Offsets the shell wall to the part 
interior. The external wall of the 
original part becomes the external 
wall of the shell 

 

Outside 
Offsets the shell wall to the 
exterior of the part. The external 
wall of the original part is the 
internal wall of the shell. 

 

Both Sides 
Offsets the shell wall equal 
distances to the inside and outside 
of the part. Adds half of the shell 
thickness to the thickness of the 
part. 

 
Thickness Specifies the thickness to be applied uniformly to 

shell walls. Part surfaces not selected for removal 
become shell walls. If you need to use the thickness 
value in a parameter table, you can highlight the 
value in the box, then right-click to cut, copy, paste, 
or delete it. 

 
 

 
 
 
The drop down on the Thickness bar allows you to measure a distance to determine the shell thickness or 
display dimensions to assist you in determining which thickness value to use.  Inventor stores the most 
common values and displays them to aid you in making a choice. 
 
The three direction buttons from left to right are Inside, Outside or Both.   
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Pressing on the double arrow button located on the lower right of the Shell dialog box enlarges the dialog 
box, providing the user with the ability to define sides with different thickness values.  To remove items 
from the unique face thickness list, highlight and press the ‘Delete’ key in your keyboard. 
 
 
 
 
 
 
 

 
Rib 
 
A Rib is a special type of extruded feature created from an OPEN sketched contour.  It adds material of a 
specified thickness in a specified direction between the contour and an existing part. 

 
TIP:   To reclaim a face, press and hold Ctrl and select the face. 
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Adding a Rib 
 
Open the file created in Lesson 1. 
 

 
 
We start by creating an offset work plane in the middle of the bracket. 
 

 
 
Highlight the extrusion in the browser.  Right click and select ‘Show Dimensions’. 
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The extrusion’s dimensions are now visible.  We see that the width is 3.25 units. 
 

 
 
Select the Work Plane tool from the Features toolbar. 
 

 
Select the face shown and start dragging the work plane into the part. 
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The Offset edit box should appear.  Enter the value –3.25/2.  The part was extruded 3.25 units. 

 
 
Our work plane now bisects the part.  Select the work plane.  Right click and select ‘New Sketch.’ 
 

  
 
 
 
 
 
 
 
 

 
TIP:   You can select the work plane for the New Sketch in the browser or in the graphics window. 
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Draw a single slanted line as shown.  Add coincident constraints for the horizontal and vertical endpoints 
and then dimension. 
 
 
 
 

 
 
Select the Rib tool. 
Set the thickness to 1 in.   
Disable the ‘Extend Profile’ box.  
Set the Extents to Finite and set the value to 0.1 in.   
Press ‘OK’. 

 
Our bracket with the rib added. 
Save the part using ‘Save Copy As’ ‘bracketwrib.ipt’.  (Remember this does not save the current file!) 

1.25

2.00
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 Loft 
 
Loft features are created by blending the shapes of two or more profiles on work planes or planar faces. 
You can include the following in a loft feature: 

� Sketches created on work planes offset from one another by a distance. The planes are usually 
parallel to one another, but any planes that are not perpendicular can be used.  

� An existing planar face, as the beginning or end of a loft.  
To use an existing face as the beginning or end of a loft, create a sketch on that face (inserts a 
sketch icon in the browser). You do not need to draw anything in the sketch, but creating the 
sketch makes the edges of the face selectable for the loft.  
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Sections Specifies the profiles to include in the loft. Click in the row then click two or more profiles.  
Your selection is identified in the dialog box by sketch number, and a new row is added. 
To remove a section, highlight and press the ‘Delete’ key on the keyboard. 

Shape Control Angle 
Represents the angle between the sketch plane and the faces created by the loft at the sketch  
plane. The default value is 90 degrees. 
Weight 
A unitless value that controls how the angle affects appearance of the loft.  
A large number creates a gradual transition, while a small number creates an abrupt  
transition. Large and small values are relative to the size of your model 
Tangent to Face 
Constrains profiles created on a planar face to be tangent to the face. 
(Angle is not selectable if Tangent to Face is selected.) 

Point Mapping Selects a point on a sketch to use as the starting point for the loft surface. 
Selecting mapping points aligns profiles linearly along the points to minimize 
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 Sweep 
 
Sweep creates a feature by moving a sketched profile along a planar path.  A sweep feature requires two 
unconsumed sketches, a profile and a path, on intersecting planes. 
 

    
Base Sweep Feature    All Other Sweeps 
 
Profile Selects one or more profiles to sweep along the 

specified path. Profiles may be nested but may not 
intersect. To select multiple profiles, press Ctrl and 
continue to select. 

Path Sets the trajectory and endpoints of the swept 
feature. The profile remains normal to the path at all 
points. 

Operation Specifies whether the sweep joins, cuts, or intersects 
with another feature. Not available for base features, 
but required for all other sweep features.  The dialog 
box on the left appears for base features.  The dialog 
box on the right appears for all other sweep features. 

Taper Sets taper angle for sweeps normal to the sketch 
plane. If taper angle is specified, a symbol shows 
the fixed edge and direction of taper. Not available 
for closed paths. 

Positive 
Angle 

Positive taper angle increases the 
section area as the sweep moves away 
from the start point. 

Negative 
Angle 

Negative taper angle decreases the 
section area as the sweep moves away 
from the start point.  

Nested 
Profiles 

The sign (positive or negative ) of the 
taper angle is applied to the outer loop 
of nested profiles; inner loops have the 
opposite sign.  
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  Coil 
 
Our last Sketch feature tool is Coil.  Start by creating the profile for the coil, usually a circle or rectangle. 
Then press the Coil tool button.   
 

 
 
Select the profile we have created.  We can adjust whether the coil will be created clockwise or 
counterclockwise using the Rotation button.  Inventor previews our selection so we can decide if the 
selection is correct.  The axis can either be defined using an existing sketch, edge or, if the profile is a 
circle, selecting the circle profile will automatically set it to the center. 
 

The Coil Shape Tab selects a profile and axis and specifies the direction of coil rotation. Profile and axis 
must be in the same sketch unless the axis is a work axis. 

Shape 

Profile 
Selects a single profile automatically. If multiple profiles exist, you must specify one.  
Axis 
A straight line or work axis that defines the axis of revolution. It cannot intersect the profile. 

Operation 

Specifies whether the coil Joins, Cuts, or Intersects with the base feature. Not available if the 
coil is the base feature (first feature in the file).  
Join 
Adds the volume created by the coil feature to another feature. 
Cut 
Removes the volume created by the coil feature from another feature. 
Intersect 
Creates a new feature from the shared volume of the coil feature and another feature. Material 
not included in the shared volume is deleted. 

Rotation Specifies if the coil rotates clockwise or counterclockwise. 
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The Coil Size Tab specifies how the coil is created by specifying Pitch, Revolution, and/or Height. Specify 
two of the three parameters; the third parameter is calculated.  

Type Selects which pair of parameters to specify: Pitch and Revolution, Revolution and Height, Pitch 
and Height, or Spiral. 

Pitch Specifies the elevation gain for each revolution of the helix. 

Height Specifies the height of the coil from the center of the profile at the start to the center of the 
profile at the end. 

Revolution 
Specifies the number of revolutions for the coil. Must be greater than zero but may include a 
fraction (for example, 1.5 turns). The number of revolutions includes the end conditions, if 
specified. 

Taper Specifies the taper angle, if desired, 1 for all coil types except Spiral. 
 
 

 
 
We can define a coil using Pitch and Revolution, Revolution and Height, or Pitch and Height.  To modify 
the values, place the mouse cursor inside the edit box and type the desired value. 
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The Coil Ends tab specifies End conditions for the Start and End of the coil. Only the helix is flattened, not 
the profile of the coil.  
Natural or 
Flat 

Click down arrow to specify Natural or Flat for both ends of the coil. Ends can have 
dissimilar end conditions. 

 

Transition angle 
The distance (in degrees) over which the coil achieves the transition (normally less than one 
revolution). The example shows the top with a natural end and the bottom end with a one-
quarter turn transition (90 degrees) and no flat angle. 

 

Flat angle 
The distance (in degrees) the coil extends after transition with no pitch (flat). Provides 
transition from the end of the revolved coil to a flattened end. The example shows the same 
coil as above, but with a half-turn (180 degree) flat angle specified.  
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Thread Tool 

 
 
This tool maps a bitmap of a thread onto a cylindrical feature. 
 

    
 
Location 
Faces Select the faces to apply the bitmap 
Display in Model When this is enabled, the bitmap is visible. 
Full Length Adds threads to the entire length when enabled. 

When Full Length is disabled, the user can specify a length and an offset from an 
end. 

Specification  
Thread Type User can select ANSI or Metric.  The default depends on which standard was 

selected during installation. 
Nominal Size User can select the diameter of the thread from a drop down list. 
Pitch User can select pitch from a drop down list. 
Class User can select from a drop down list. 
Right/Left Hand Determines the direction of the thread. 
 
 
Placed Feature Tools 
 

  
 
Our Placed Feature Tools are FILLET, CHAMFER, FACE DRAFT, and SPLIT. 
 

 FILLET 

You can include a fillet in your design by adding a 2D fillet when sketching. A 2D sketched fillet and a 
fillet feature can produce models that are identical in appearance. Although the results look the same, the 
model with the fillet features has several advantages: 

� A fillet feature can be edited, suppressed, or deleted independent of the extrusion feature, without 
returning to the original sketch.  

� If the remaining edges are to be filleted, you have more control over the corners.  
� You have more flexibility when performing subsequent operations such as applying face draft.  
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Because other features may affect fillets and rounds, add the fillets and rounds toward the end of the 
modeling process. For example: 

� It is easier to add draft to a face that intersects with other faces at a sharp angle, so it is better to 
add draft to a face before adding fillets.  

� Fillets can increase the time required to update when feature dimensions change. To work most 
efficiently, add the features of the basic design early and wait until the end of the process to add 
features such as fillets.  

� Reordering features can cause existing fillet features to produce undesired results. Adding features 
such as fillets and chamfers at the end of the modeling process can minimize problems.  

When filleting adjacent edges, you can add the fillets separately or fillet all edges in one operation. 
Consider the following when deciding whether to use single or multiple operations: 

 

When adding fillets with the same radius to three adjacent edges, the result is the same 
whether you add them separately or in one operation. The most efficient method is to add them 
in one operation. 

 

If each edge has a different radius, use a single fillet operation, if possible, to ensure a smooth 
corner. This situation always results in a blended corner. 

 

When two edges have the same radius and the third edge has a different radius, use a single 
fillet operation if possible. If you add the fillets as separate operations, the edge with the larger 
radius must be filleted first. 

 

When filleting four or more edges, fillet all edges as a single operation 

If a fillet is applied to a single edge, any operation that deletes the edge results in an error condition, since 
the fillet is no longer valid. If a fillet feature is applied to multiple edges, you can delete an edge and the 
fillet will update to reflect the change, as long as any edge in the set remains.  

You can create constant-radius and variable-radius fillets and fillets of different sizes in a single operation. 
All fillets and rounds created in a single operation become a single feature. 
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Selecting the Fillet tool brings up the dialog box shown.  On the right side, we can set the selection mode of 
what we want to select.  For example, enabling the ‘All Fillets’ mode, would select all the current fillets 
defined on the model.   
 

The Constant Tab sets the parameters for adding constant-radius fillets. If necessary, set the options on the 
Options tab before creating the fillets. 

Edges 

Defines a set of edges to fillet. To add edges, select the set from the Edges box, then click the 
edges in the graphics window. (To remove edges, press Ctrl as you click.) To add another edge 
set, click the prompt in the last row of the Edges box. Use Select Mode to simplify the selection 
of edges.  

Radius 
Specifies the fillet radius for the selected set of edges. To change the radius, click the radius 
value, then enter the new radius.  

Select 
Mode 

Changes the selection method for adding or removing edges from an edge set. Click to select the 
mode from the list.  
Edge selects or removes single edges. 
Loop selects or removes the edges of a closed loop on a face. 
Feature selects or removes all edges of a feature that do not result from intersections between the 
feature and other faces. 
Fillets selects or removes all remaining concave edges and corners. This mode requires a separate 
edge set. 
Rounds selects or removes all remaining convex edges and corners. This mode requires a 
separate edge set. 

 

  
 

The Variable Tab sets the parameters for adding variable-radius fillets. If necessary, set the options on the 
Options tab before creating the fillets. 

Edges 
Specifies edges to fillet. To add an edge, select the prompt in the Edges box, then click the edge 
in the graphics window.  

Point Selects the start point, endpoint, or an intermediate point so that you can enter its radius. 

Radius 
Sets the fillet radius at the selected point. To change the radius, select the point in the point list, 
then enter the new radius. 

Position 
Specifies the position of the selected point. To change the position, select the point in the point 
list, and then enter a value between 0 and 1 as a percentage of the length of the edge.  

 
To create a variable fillet,  select the Variable tab.  Select an edge.  The user is then prompted for a series of 
points along the edge.  As the user picks each point, he can assign a value for the radius at that point. 
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TIP:   To select a single edge without selecting edges that are tangent to it, turn off Automatic Edge 
Chain on the Options tab. 

 
TIP:   To select a single edge segment without selecting edges that are tangent to it, turn off Automatic 
Edge Chain on the Options tab. 
 
If the selected edge contains multiple tangent edge segments, the position is relative to the start point of 
individual edge segment on which the point resides. 
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The Options tab sets the corner preference, transition type, and edge chain preference for fillets and rounds. 
The default settings for these options are correct for most fillet features. 

Corner 
Preference 

Sets the corner style for the fillets. Rolling ball is the default setting.  

 

Rolling Ball creates a fillet defined as if a ball had been rolled along the edge 
and around the corners. 

 

Blend creates a continuous tangent transition between fillets in sharp corners. 

 

Transition 

Defines how variable-radius fillets are created between control points. Smooth is the 
default setting.  

 

Smooth creates fillets with a gradual blending transition between the points. 
The transition is tangent (no rate of change between points). 

 

Straight creates fillets with linear transitions between the points. 

 

Automatic 
Edge Chain 

When the check box is selected, selecting an edge to fillet selects all tangent edges 
automatically. When the check box is cleared, only the indicated edge is selected. The 
default setting is on.  

Preserve All 
Features 

When the check box is selected, all features that intersect with the fillet are checked and 
their intersections are calculated during the fillet operation. If the check box is cleared, only 
the edges that are part of the fillet operation are calculated during the operation.  

 
 
 
 
 
 
 
 

 
TIP:   To select part of an edge that already has filleted corners, clear the check box. 
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 Chamfer 
 

  
 
You specify the corner appearance and select edges individually or as part of a chain. All chamfers created 
in a single operation are one feature. 
 
Method 
Specifies how the chamfer is constructed 

 

Distance 

 

Creates a chamfer with the 
same offset distance from 
the edge on both faces. 
Selects a single edge, 
multiple edges, or chained 
edges. Corner setback 
appearance may be 
specified. 

 

Distance 
and Angle 

 

Creates a chamfer defined 
by an offset from an edge 
and an angle from one face 
to the offset. Any/all edges 
of a selected face may be 
chamfered at once. 

 

Two 
Distances 

 

Creates a chamfer on a 
single edge with a specified 
distance for each face.  
Edges may be chained 
together. 

 
Edges and Faces 
Selects one or more edges or faces. Pressing Ctrl while clicking 
removes geometry from the selection. 

Edges 
Selects individual edges to chamfer and previews 
default distance.  

Face 
For chamfers defined by a distance and angle, 
selects the affected face. 
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Flip For chamfers defined by two distances, flips the direction of the 

chamfer distances. 
Distance and Angle Specifies the extent of selected chamfer method. 

Distance 
Specifies offset distance of chamfer from selected 
edge(s). For chamfer defined by two distances, 
specifies both offsets. 

Angle 
For chamfers defined by a distance and angle, 
specifies the angle of the chamfer. 

 
If edges intersect at a tangent point, edge chain and setback 
appearance may be specified. 

Edge Chain Selects all edges that share a tangent point. 

Setback 

For the Distance chamfer method, defines corner 
appearance when three chamfered edges meet at a 
corner.  

 

Chamfer may be joined at a flat 
intersection (left button). 

 

Chamfer may form a corner 
point at the intersection, as if 
milled on three edges (right 
button). 

  
 
The three modes of chamfers are located on the left side of the dialog box.  The top tool is for Equal 
Distance.  The middle tool is for Distance-Angle.   The bottom tool is for two different Distance values.  
Note that on the lower right corner there is a double arrow (More) button. 
 

  
 
Pressing the double arrow brings up additional chamfer options.   The Edge Chain option controls whether 
the chamfer affects all tangential edges or only the selected edge.  The Setback option controls whether or 
not a setback is added. 
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 Face Draft 
 
A face draft is a slight angle applied to the walls of a part. 
 

  
 
Draft is a taper applied to part faces so that a part can be retrieved from a mold or to cant one or more faces. 
When designing features for molded or cast parts, you can apply draft by specifying a taper angle for an 
extrusion or sweep. To add draft to an existing feature or to individual faces, use the Face Draft tool. 
When applying draft to a face, the relationship between the pull direction and the fixed edge determines the 
result of the operation. 
 

� If you select a set of tangent continuous faces (like a staircase with fillets at the edges), draft is 
applied to all faces. In the browser, this draft is labeled TaperShadow.  

� If you select a face that is not tangent to another face, draft is applied to that face only. In the 
browser, this draft is labeled TaperEdge.  

Pull Direction Indicates direction in which a 
mold is pulled from a part. As 
you move the cursor in the 
graphics window, a vector 
displays normal to a highlighted 
face or along a highlighted edge. 
When the vector displays as 
desired, click to select it and 
display the direction arrow. 

Flip 
Direction 

Reverses the pull-
direction arrow. 

Accept 
Accepts the 
displayed pull 
direction. 

 

Faces Specifies the faces to which draft 
will be applied. As you move the 
cursor over a face, a symbol 
indicates the fixed edge for the 
draft and how the draft will be 
applied. Click to select the 
desired fixed edge. 

 

Draft Angle Sets the angle of the draft. Enter 
the angle or choose a calculation 
method from the drop-down list. 

 

 
 
 
 
 
 

 
TIP:   The first edge selected determines the curves you can select for draft. For example, if the first edge 
you select is linear, you cannot select edges with continuous tangency. 
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Applying a Face Draft 

Click the Face Draft tool.  

1. To define the pull direction, move the cursor over a feature until the direction vector is aligned 
with the desired pull direction, then click to select.  

2. If necessary, click the Flip Direction button to change the pull direction.  
3. Select the faces to draft. As you move the cursor over a face, a symbol indicates the fixed edge 

and direction for the draft.  
4. Enter the draft angle.  
5. Click OK.  

  

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
TIP:   To select part of an edge that already has filleted corners, clear the check box. 

If a face is tangent to other faces, all tangent faces are highlighted.  
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 Split 
 
Part Splitting is a fast and easy way to create a top and bottom for a box or enclosure.  It ensures that the 
parts mate properly.  To create a split, the easiest method is to place an offset work plane at the location for 
the split and then use the work plane for the split operation.  We can split part faces or an entire part and 
remove one of the resulting sides.   This tool allows faces on both sides of the split to have draft applied. 
 

  
 

Split Part Selects part to split and discards one side. 

Split Face Selects one or more faces to split into two pieces. 
Split tool Selects workplane or parting line used to split face or part into two pieces. 

 
All  Selects all faces to split. Click OK. 
Selected Selects faces to split. Click Faces to Split tool, select faces to split, then click OK.  

When Split Part method is active, click Side to Remove button to preview, then click OK to remove 
specified side. 
 
Selecting the Split tool brings up the dialog box shown.  The user has two options under Method:  Splitting 
the Part (left icon) and Splitting a Face (right icon).   

The Split tool can be a workplane or sketch a parting line on a workplane or part face. The sketched parting 
line can include lines, arcs, and splines. 

By default, Split removes one side of a split part. If you need to split a part into two parts you can use this 
procedure: 

1. Sketch a parting line on a part face.  
2. On the File menu, use Save Copy As to save the part with the parting line and both halves intact.  
3. Use the Split tool to split the part and remove the selected half.  
4. Use Save Copy As to save the first half of the part.  
5. Open the original file, then use the Split tool to remove the other half of the part.  
6. Use Save Copy As to save the second half of the part.  

Both halves of the part are now saved in separate files. 
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The next section of the Features tool bar contains the Catalog flyout tools and the Derived Component tool. 
 

 View Catalog 
 
The Catalog is similar to AutoCAD Design Center.  The user can browse a library of parts and blocks that 
can be inserted into the current file. 
 
 

 
 
Inventor includes a set of features ready for use.  Users can explore the pre-existing library of sketches to 
save time when constructing their models. 
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The library features can be previewed using the Insert tool. 
 

 Insert Design Element 
 

 
 
Selecting this tool brings up the dialog box shown.  Select the ‘Browse’ button to locate the element to be 
added to the model. 
 



The Features Toolbar 

Page 5-35 
 

 
 
The user can then select the element category. 
 

 
 
Once we get into the category area, we can preview each element to determine which one we want. 
 
Select the desired element and press ‘Open’. 
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Once the element is selected, the next dialog appears.  The user is required to select the plane on the 
existing model to place the element. 
 

 
 
The user is then prompted for the values for the element to be placed.  At this time, the user can specify his 
specifications for the design element. 
 
 
 

 
 
The user is then allowed to set whether to enter Sketch Edit mode immediately upon placement.  Entering 
Sketch Mode allows the user to reposition the element or make further modifications to the basic element. 
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Modifying the inserted element is exactly the same as if we had created the sketch from scratch.   
 

 Create Design Element 
 
 
We start by creating a basic shape.  In this case, I’ve created a basic keyhole slot.   
 

        
 

 We use the Create Design Element tool located on the Features toolbar.  If you don’t see the tool, it is 
because it is a flyout option under the View Catalog tool. 

 
 
 
 
 
 
 
 
 
 
 

 
TIP:  The sketch must be turned into a feature using Extrude, Revolve, or Sweep BEFORE it can 
be turned into a design element. 
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Initiate the Create Design Element command.  To select the feature, simply pick it from the Browser. 
The window with the selected features will fill in as shown. 
 
To define the variable parameters for the design, highlight it and then select the top double arrow.  We can 
rename the parameter to allow useful prompting. 
 

 
 
Notice that when a parameter is highlighted, the top double arrow becomes available to insert into the Size 
Parameters. 
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In this example, we have defined the design parameters to be the large hole, the small hole, and the vertical 
distance between the holes.  Notice that the 0.00-inch dimension which forces the holes to line up is 
omitted at a user-defined parameter.  In this way, we can control our design elements and decide which 
geometries are changeable and which are not. 
 

 
 
 
When we press ‘SAVE’, we get the Catalog.  Since this is a keyhole slot, we will place this design element 
in the Slots Category. 
 
 
 
 
 
 
 
 
 
 
 

 
 
TIP:   When naming parameters, you can not use spaces, dashes or other punctuation marks.  If you use 
an invalid character, you will get an error message to provide a proper name. 
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Pressing the Options button on the far right allows the user to set whether or not to create a Preview Picture 
of the design element and how it should be captured. 
 

 
 
We select the Slots category and assign the filename ‘Keyhole’ to our design element. 
 

  Derived Part 
 

Creates a new derived part using an Autodesk Inventor part as the base part. The derived part can be scaled 
larger or smaller than the original part or mirrored using any of the origin workplanes of the base part. The 
location and orientation of the derived body is the same as the base part. 

Access:  Insert>Derived part 

Scale factor Default value is 1.0. Scale factor may be expressed in whole numbers of percentages 
(expressed with a decimal). Click arrow to select from recently used values. 

Mirror body Mirrors part when check box is selected. Specifies X, Y, or Z origin workplanes as 
the mirror plane. Click arrow to select plane. 



The Features Toolbar 

Page 5-41 
 

 

To capture design intent, you can use an Autodesk Inventor part as the basis for a derived part. A derived 
part is a new part that uses an existing part as its base feature. You can add features to the derived part 
feature (the base feature), and update it to incorporate changes made to the original part.  
 
You can use the derived part to explore design alternatives and manufacturing processes. You can add 
features to the derived part feature and create multiple derived parts from one original design. For example: 

� A casting blank can be machined several different ways.  
� A standard length of tubing can be machined in different configurations.  

Changes to the original part do not affect the derived part unless you specifically request an update. For 
example, you can insert a part into a file as the base feature of the derived part. You can add features to the 
derived part feature (base feature) to modify it. When you click the Update button on the Command bar, the 
derived part feature does not update, but all other features update.  

To update the derived part feature, right-click on the part in the browser and select Update. Changes made 
to the original part are reflected in the updated derived part feature. 

A derived part is linked to its original part so changes to the original part can be incorporated. You can 
modify the derived part feature and save the file, but changes to the original part will not affect it unless 
you specifically update the derived part feature.  

You can break the link to the original part if you no longer wish to update the derived part feature. Right-
click on the derived part feature in the browser and select Break Link. The derived part feature becomes a 
regular feature and its changes are saved only in the current file. 
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Our next section allows us to pattern or mirror features. 
 

 Rectangular Pattern 

Use the Rectangular Pattern tool on the Feature toolbar to duplicate a feature and arrange the resulting 
features in a rectangular pattern.  You can arrange the features in rows and columns by a specific count and 
spacing, suppressing individual features if desired. 

 

1. Click the Rectangular Pattern tool.  
2. Click in the graphics window to select the feature to duplicate and arrange in a pattern.  
3. Click Column Placement, then click an edge or work axis to indicate the direction of the column. 

Click Flip to change the column direction, if desired.  
4. Enter the count (number of features) for the column and the spacing between features.  
5. If the pattern has multiple rows, Click Row Placement and set the row direction, count, and 

spacing.  
6. If desired, click the More button to set a Creation Method:  

o Choose Identical to create identical features, regardless of termination.  

Choose Adjust to Model to terminate features when it encounters a face. 

 
TIP:   Patterns created with the Identical method calculate faster than the Adjust to Model method. Using 
Adjust to Model, the pattern terminates if it encounters a planar face, and may result in a feature whose size 
and shape differs from the original. 
 
You can suppress individual occurrences in a pattern (except the original feature) to allow the pattern to flow 
around another feature, an irregular shape, or create a missing-tooth pattern. In the browser, right-click the 
occurrence and click Suppress. 
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  Circular Pattern 

Use the Circular Pattern tool on the Feature toolbar to duplicate a feature and arrange the resulting features 
in an arc or a circle 

 

To begin, create the one or more features to include in the pattern. 

1. Click the Circular Pattern tool.  
2. Select the feature to arrange in a pattern.  
3. Click the axis (pivot point of angle) about which occurrences are repeated. The axis can be on a 

different plane from the feature being patterned.  
4. In the Count box, enter the number of occurrences in the pattern.  
5. In the Angle box, enter the angle, as follows:  

o For Incremental positioning, the angle specifies the spacing between occurrences.  
o For Fitted positioning, the angle specifies the total area the pattern feature occupies.  

6. Click the Flip button to reverse the direction of the pattern, if desired.  
7. If desired, click the More button to specify the following options:  

o Under Creation Method, click Identical to create identical features or click Adjust to 
Model to terminate features when it encounters a face.  

o Under Positioning Method, click Incremental to space occurrences at the angle specified 
or click Fitted to arrange occurrences within the specified angle.  

Click OK. 

 

 

 

 

 

 

TIP:   Patterns created with the Identical method calculate faster than the Adjust to Model method. 
Using Adjust to Model, the pattern terminates if it encounters a planar face, and may result in a feature 
whose size and shape differs from the original.  

You can suppress individual occurrences in a pattern (except the original feature) to allow the pattern to 
flow around another feature, an irregular shape, or create a missing-tooth pattern. In the browser, right-
click the occurrence and click Suppress. 
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  Mirror Feature  

Use the Mirror tool on the Features toolbar to mirror one or more features at equal distances across a plane. 

To begin, create one or more features to mirror. Create a work plane to serve as the mirror plane or, if you 
prefer, identify a planar face to use. 

1. Click the Mirror tool.  
2. Click one or more features to mirror.  
3. Click Mirror Plane and select a work plane or planar face.  
4. If desired, click the More button to choose one of the following Creation Methods:  

o Click Identical to create identical mirrored features, regardless of termination.  

Click Adjust to Model to terminate features on model planes. 

 

 

 

 

 

 

TIP:   Features mirrored with the Identical method calculate faster than the Adjust to Model method. 
Using Adjust to Model, the mirrored feature terminates if it encounters a planar face, and may result in a 
feature whose size and shape differs from the original.  
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Create Work Plane 

Use the Work Plane tool on the Feature toolbar to define a work plane using unconsumed sketch geometry, 
feature vertices, edges, faces, or other work features. Work planes can also be created in-line when a work 
feature command requires you to select a plane.  

Use one or more of the following relationships to define a work plane:  

� On geometry (on three points, for example)  
� Normal to geometry  
� Parallel to geometry  
� At an angle to geometry (on a plane and an axis)  

1. Click the Work Plane tool.  
2. Select appropriate vertices, edges, or faces to define a work plane.  

For offset work planes, drag the work plane to desired location and enter a distance or angle in the 
Offset dialog box. Click the check mark in the dialog box to accept the preview and create the offset 
work plane. 

If desired, you can create multiple work planes offset from one another at a specific distance or angle. 
Follow the steps above, selecting the last created work plane as the sketch plane, then drag the new work 
plane to the desired offset distance. 

 

 

 

 

 

 

 
TIP:   If more than one solution is possible, a selection box appears. Click the forward or reverse arrows 
in the selection box, then click the check mark when the correct solution is previewed. 
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Work Axis 

Use the Work Axis tool on the Feature toolbar to designate unconsumed sketch geometry, points, or a part 
edge as a work axis. Work axes can also be created in-line as input to other work feature commands. 

1. Click the Work Axis tool.  
2. Select one of four methods:  

o Select a revolved feature to create a work axis along its axis of revolution.  
o Select two valid points to create a work axis through them.  
o Select a work point and a plane (or face) to create a work axis normal to the plane (or 

face) and through the point.  

Select any two non-parallel planes to create a work axis at their intersection. 

   
Work Point  

Use the Work Point tool on the Feature toolbar to select model vertices, edge and axis intersections, 
intersections of three non-parallel faces or planes, and other work features as work points.  

Work points can also be created as input to other work feature commands that require you to select a point. 
Work points are partially constrained in place relative to vertices, edges, and other topological 
characteristics of the parent part or feature. 
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Feature Tools 
 
Button Tool Function Special Instructions 

 
Extrude Extrude a profile normal to the 

sketch 
Can be base feature 

 
Revolve Revolve a profile around an axis Can be base feature 

 
Hole Create a hole in a part Use hole points or line endpoints 

as hole centers 

 
Shell Create a hollow part Placed feature 

 
Rib Creates a rib Uses an open contour 

 

Loft Construct a feature with varying 
cross sections; can follow a 
curved path 

Requires multiple work planes 

 

Sweep Extrude a profile along a curved 
path 

Can be base feature 

 

Coil Extrude a profile along a helical 
path 

Can be base feature 

 
Thread Maps a bitmap of a thread to a 

cylindrical face. 
 

 
Fillet Create a fillet or round edges Placed feature 

 
Chamfer Create a chamfer on selected 

edges 
Placed feature 

 
Face Draft Create a draft on selected faces Placed feature 

 
Split Part Split using parting line or 

spline 
 

 
View Catalog Open a Catalog of Design 

Elements 
 

 
Insert Design 
Element 

Add a Design Element  

 
Create a 
Design 
Element 

Create a Design Element from an 
Existing Feature 

 

 
Derived Part Create a new derived part from a 

base part 
 

 
Rectangular 
Pattern 

Creates a rectangular pattern of 
features 

Pattern can be suppressed, items 
in the pattern can be 
individualized 

 
Circular 
Pattern 

Creates a circular pattern around a 
center  

Pattern can be suppressed, items 
in the pattern can be 
individualized 

 
Mirror 
Feature 

Create a mirror image using a 
plane, line or axis as mirror line 

 

 
Work Plane Create a work plane  

 
Work Axis Create a work axis  

 
Work Point Create a work point Can be used to place holes on 

curved surfaces 
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Review Questions 
 

 
 
Identify the icon. 
 

1. Hole 
2. Extrude 
3. Coil 
4. Loft 
 

 
 
Identify the icon. 
 

5. Part Splitting 
6. Face Draft 
7. Fillet 
8. Chamfer 
 

9. A Derived Part is: 
 

A. Used to explore different design ideas 
B. A copy of a base part 
C. Can be scaled or mirrored 
D. All of the above 

 
10.   The three options for creating a chamfer are: 

 
A. Equal distance, distance-angle, two distances 
B. Variable, constant, radial 
C. Equal Distance, Variable Distance, Distance-Angle 
D. Two angles, Two Distances, Equal Distance 

 
 
 
 
 
 
 
 
 
ANSWERS:  1) B; 2) A; 3) D; 4) C; 5) D; 6) C; 7) A; 8) B; 9) D; 10) A 
 


